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2004/108/EC and as supported by the European Commission’s Guide for the EMC Directive 2004/108/£C
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For information regarding the exclusive, limited warranties applicable to Microchip products, please see
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Preface

NOTICE TO CUSTOMERS

of the document.

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs and/
or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level

For the most up-to-date information on development tools, see the MPLAB® X IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
Buck/Boost Converter PICtail™ Plus Daughter Board. Items discussed in this chapter
include:

Document Layout

Conventions Used in this Guide

Recommended Reading

The Microchip Web Site

Development Systems Customer Change Notification Service
Customer Support

Document Revision History

DOCUMENT LAYOUT

This document describes how to use the Buck/Boost Converter PICtail™ Plus
Daughter Board. This user’s guide is composed of the following chapters:

Chapter 1. “Introduction” describes the Buck/Boost Converter PICtail™ Plus
Daughter Board and provides a brief description of the hardware.

Chapter 2. “Hardware Description” describes the board hardware.

Chapter 3. “Getting Started” describes the step-by-step process for getting your
board up and running with the MPLAB® In-Circuit Debugger 3 (ICD 3) using a
dsPIC33FJ16GS502 device.

Chapter 4. “Demonstration Program Operation” describes the operation of the
Buck/Boost Converter PICtail™ Plus Daughter Board.

Appendix A. “Board Schematics and Layout” illustrates the layout and
provides hardware schematic diagrams for the board.

Appendix B. “Bill of Materials (BOM)” provides the Bill of Materials (BOM) for
the Buck/Boost Converter PICtail™ Plus Daughter Board.

© 2008-2014 Microchip Technology Inc. DS70000336C-page 7
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

Represents

Examples

Italic characters

Referenced books

MPLAB X IDE User’s Guide

Emphasized text

...Is the only compiler...

dialog

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or “Save project before build”

Underlined, italic text with | A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

Text in angle brackets <>

A key on the keyboard

Press <Enter>, <F1>

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New

A variable argument

file.o, where file can be any
valid filename

that we want to re-emphasize,
either to help you avoid a
common pitfall or to make you

aware of operating differences

between some device family
members. A Note can be in a

box, or when used in a table or

figure, it is located at the
bottom of the table or figure.

Square brackets [ ] Optional arguments mccl8 [options] file
[options]
Curly brackets and pipe | Choice of mutually exclusive errorlevel {01}
character: {|} arguments; an OR selection
Ellipses... Replaces repeated text var name [, var name...]
Represents code supplied by |void main (void)
user {
}
Notes A Note presents information

Note:
note box.

CAUTION

This is a caution note.

This is a standard |

Note 1: Thisis anoteusedina
table.

DS70000336C-page 8
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RECOMMENDED READING

This user’s guide describes how to use the Buck/Boost Converter PICtail™ Plus
Daughter Board. The following Microchip documents are available and recommended
as supplemental reference resources.

Readme for Buck/Boost Converter PICtail™ Plus Daughter Board

For the latest information on using the Buck/Boost Converter PICtail™ Plus Daughter
Board, read the Readme . txt text file in the Readme subdirectory of the MPLAB X IDE
installation directory from the Buck/Boost Converter PICtail Plus Daughter Board CD.
The Readme file contains update information and known issues that may not be
included in this user’s guide.

Readme Files

For the latest information on using other tools, read the tool-specific Readme files in
the Readme subdirectory of the MPLAB X IDE installation directory. The Readme files
contain updated information and known issues that may not be included in this
user’s guide.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at http://www.microchip.com. This
web site makes files and information easily available to customers. Accessible by most
Internet browsers, the web site contains the following information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

* General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listings

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listings of seminars and events; and listings of Microchip sales
offices, distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip
products. Subscribers will receive e-mail notification whenever there are changes,
updates, revisions or errata related to a specified product family or development tool of
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

» Compilers — The latest information on Microchip C compilers and other language
tools

* Emulators — The latest information on the Microchip in-circuit emulator,
MPLAB REAL ICE™

 In-Circuit Debuggers — The latest information on the Microchip in-circuit
debugger, MPLAB ICD 3

* MPLAB X IDE — The latest information on the Microchip MPLAB X IDE, the
Windows® Integrated Development Environment for development systems tools

* Programmers — The latest information on Microchip programmers including the
PICkit™ 3 development programmer

© 2008-2014 Microchip Technology Inc. DS70000336C-page 9
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative

* Local Sales Office

+ Field Application Engineer (FAE)

» Technical Support

Customers should contact their distributor, representative or field application engineer

(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY
Revision A (August 2008)

This is the initial release of this document.

Revision B (December 2010)

This revision of the document contains the following updates:

» Added references to the dsPIC33FJ64GS610 device, which can be used with the
Explorer 16 Development Board throughout the document

» Added Appendix B. “Bill of Materials (BOM)”

» Formatting updates and minor changes to the text have been incorporated
throughout the document

Revision C (November 2014)

This revision of the document contains the following updates:
» Tables:

- Updated Table 2-2
+ Sections:

- Updated note in Section 2.6.1 “16-Bit 28-Pin Starter Development Board
Controls Buck 1 and Buck 2 Stages (Default Jumper Configuration)”

- Updated Section 2.4.7 “VOUT3 J8 (Boost)”
- Updated note in Section 2.6.2.2 “Software”
- Updated Section 2.7.3 “Boost Converter”
» Figures:
- Updated Figure A-3, Figure A-4
» Changes to text and formatting were incorporated throughout the document
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Chapter 1. Introduction

1.1 OVERVIEW

This chapter describes the features and functions of the Buck/Boost Converter
PICtail™ Plus Daughter Board.

Modern power supplies are becoming smaller, more efficient, more flexible and less
expensive. These desirable enhancements have come about as Digital Signal
Controllers (DSCs) are incorporated into Switch Mode Power Supply (SMPS) designs.
Buck Converters are used when the desired output voltage is smaller than the input
voltage. Boost Converters are used when the desired output voltage is higher than the
input voltage.

The Buck/Boost Converter PICtail Plus Daughter Board is a power supply board. It
consists of two independent DC/DC synchronous Buck Converters and one
independent DC/DC Boost Converter.

1.2  HIGHLIGHTS

This chapter covers the following topics:

» Buck/Boost Converter PICtail™ Plus Daughter Board
* Features
* Product Package

1.3 BUCK/BOOST CONVERTER PICtail™ PLUS DAUGHTER BOARD

The Buck/Boost Converter PICtail Plus Daughter Board block diagram is shown in
Figure 1-1.

The power, drive and control signals are available in the J1 and J2 connectors. The
16-Bit 28-Pin Starter Development Board can be used to control one independent
DC/DC synchronous Buck Converter. This board can also control two buck stages, or
one buck and one boost stage with hardware modification on the 16-Bit 28-Pin Starter
development Board (see Section 2.6.2 “16-Bit 28-Pin Starter Development Board
Controls Buck 1 and Boost Stages”).

The block diagram of the daughter board using the 16-Bit 28-Pin Starter Development
Board is shown in Figure 1-2. All three stages of the Buck/Boost Converter PICtail Plus
Daughter Board are controlled by the Explorer 16 Development Board. The

figure shows a block diagram of the daughter board using the Explorer 16
Development Board.

The control boards provide closed-loop Proportional-Integral-Derivative (PID) control in
software to maintain the desired output voltage level. The dsPIC® DSC device provides
the necessary memory and peripherals for Analog-to-Digital (A/D) conversion,
Pulse-Width Modulator (PWM) generation, analog comparison and general purpose
I/O, excluding the need to perform these functions in an external circuitry.

The dsPIC® DSC SMPS devices are specifically designed to provide low-cost and
efficient control for a wide range of power supply topologies. The specialized
peripherals facilitate closed-loop feedback control of Switch Mode Power Supplies,
providing communication for remote monitoring and supervisory control.

© 2008-2014 Microchip Technology Inc. DS70000336C-page 11
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The daughter board enables the end user an easy transition from Analog-to-Digital
implementation of the power application. The daughter board also aids in the rapid
development of the Buck Converter, Boost Converter, multi-phase Buck Converter and
two parallel Buck Converters.

The dsPIC33F SMPS family of devices provides the following features:

Integrated program and data memory on a single chip
Ultra-fast interrupt response time and hardware interrupt priority logic

Up to 4 Msps, on-chip ADC with two SARs, and up to four dedicated and
two shared Sample-and-Hold circuits for multiple loop control

Four independent, high-resolution PWM generators specially designed to support
different power topologies

Four analog comparators for control loop implementation and system protection
On-chip system communications (I°C™/SPI/UART)

On-chip Fast RC (FRC) oscillator for lower system cost

High-current sink/source for PWM pins: 16 mA/16 mA

CPU performance: 40 MIPS

Extensive power savings

CodeGuard™ Security enabled

DS70000336C-page 12
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FIGURE 1-1: DAUGHTER BOARD BLOCK DIAGRAM
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FIGURE 1-2: 16-BIT 28-PIN STARTER DEVELOPMENT BOARD WITH DAUGHTER BOARD
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FIGURE 1-3: EXPLORER 16 DEVELOPMENT BOARD WITH DAUGHTER BOARD
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1.4 FEATURES

The Buck/Boost Converter PICtail Plus Daughter Board includes these features:

1.4.1 Power Stages

» Two synchronous Buck Converter power stages

* One Boost Converter power stage

 Voltage/current measurement for digital control of Buck Converters

+ Voltage/current measurement for digital control of Boost Converter

» Switchable, one 5Q/5W resistive load on Buck Converter 1 Output (VOUT1)
* Buck Converter 1 Output (VOUT1) on J4 connector for external loading

* Buck Converter 2 Output (VOUT2) on J5 connector for external loading

» Boost Converter Output (VOUT3) on J8 connector for external loading

» Connector J9 for auxiliary power input

1.4.2 Additional Features

* 5 kQ potentiometer (RP1) connected through jumper J10

* Input voltage source selection through jumper J6

+ Additional resistive load (R46) through jumper J11

» Connectors J1 and J2 (Explorer 16/16-Bit 28-Pin Starter Development Board)
* PMBus™ connector (J3)

14.3 Daughter Board Power

* Auxiliary power input (J9): +7V to +15V (+9V nominal)
* 9V power input is through input connectors J2 and J1
» LED power-on indicator (D14)

» LED output voltage indicators (D11, D12 and D13)

Note: The 9V inputis supplied from the controller card (16-Bit 28-Pin Starter
Development Board or Explorer 16 Development Board). All 16-Bit 28-Pin
Starter Development Boards must have a blue wire connecting Pin 1 of J1
to Pin 28 of J2. If no blue wire connects Pin 1 of J1 to Pin 28 of J2, connect
a wire in-between to supply the 9V input to the Buck/Boost Converter
PICtail Plus Daughter Board.

1.5 PRODUCT PACKAGE

The Buck/Boost Converter PICtail Plus Daughter Board kit consists of the following:
* Buck/Boost Converter PICtail Plus Daughter Board
» Buck/Boost Converter PICtail Plus Daughter Board CD

The CD consists of the application software, example code, Readme file and the
User’s Guide.

DS70000336C-page 16 © 2008-2014 Microchip Technology Inc.
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Chapter 2. Hardware Description

21 OVERVIEW

This chapter provides a detailed description of the hardware elements and components
of the Buck/Boost Converter PICtail™ Plus Daughter Board.

2.2 HIGHLIGHTS

This chapter covers the following hardware sections:

» Daughter Board Connectors

» Daughter Board User Hardware Interface

» Using the Daughter Board with the Explorer 16 Development Board

» Using the Daughter Board with the 16-Bit 28-Pin Starter Development Board
» Power Rating of Converter Stages

2.3 DAUGHTER BOARD CONNECTORS

The Buck/Boost Converter PICtail Plus Daughter Board consists of different power
sections, along with the input and output connectors for signal and power connections.
Figure 2-1 shows the daughter board, the input and output connectors and their
locations.

© 2008-2014 Microchip Technology Inc. DS70000336C-page 17
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FIGURE 2-1: BUCK/BOOST CONVERTER PICtail™ PLUS DAUGHTER BOARD
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1. J1 - To connect Explorer 16 Development Board 5. J5 — VOUT2 connector
2. J2 — To connect 16-Bit 28-Pin Starter Development Board 6. J8 — VOUT3 connector
3. J3 — PMBus™ interface connector 7. J9 — Auxiliary input power connector

4. J4 —VOUT1 connector

Note: The Buck/Boost Converter PICtail Plus Daughter Board can be controlled by either of two
controller boards. Either the 16-Bit 28-Pin Starter Development Board with the
dsPIC33FJ16GS502 device or the Explorer 16 Development Board with the
dsPIC33FJ64GS610 device, which can be used to control the DC/DC power sections of the
daughter board. The connectors, J1 and J2, provide the necessary signals for control purposes.

DS70000336C-page 18 © 2008-2014 Microchip Technology Inc.
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24 DAUGHTER BOARD USER HARDWARE INTERFACE

This section describes the hardware interface of the daughter board and the power
rating of each converter’s section. Figure 2-2 shows the hardware elements
(pin headers, jumpers, LED and potentiometer).

FIGURE 2-2: BUCK/BOOST CONVERTER PICtail™ PLUS DAUGHTER BOARD
HARDWARE ELEMENTS

J11
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241 Auxiliary Input Power Connector J9

The daughter board can be connected to the auxiliary/bench power DC source through
the J9 input connector. The Jumper, J6, must be removed while working with the
auxiliary/bench power DC source (see Figure A-5 for the location of jumper, J6).

2.4.2 PMBus Interface Connector J3

The daughter board allows the user to implement the PMBus on the dsPIC DSC SMPS
device using the J3 connector (see Figure A-6 for the location of this jumper).
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243 16-Bit 28-Pin Starter Development Board Connector J2

The two converter stage sections of the daughter board can be controlled using the
16-Bit 28-Pin Starter Development Board. Table 2-1 lists all the power and signal
connections on the daughter board J2 connector to the user interface with the 16-Bit
28-Pin Starter Development Board. See Figure A-6 for the location of this connector.

TABLE 2-1: SIGNAL AND POWER CONNECTION FOR 16-BIT 28-PIN
STARTER DEVELOPMENT BOARD (J2)
P';r?nl:;nr:er Assignment Primary Use

1 NC Not Connected
2 ANO Analog Input 0 (Buck Converter 1 current)
3 AN1 Analog Input 1 (Buck Converter 1 voltage)
4 AN2 Analog Input 2 (Buck Converter 2 current)
5 AN3 Analog Input 3 (Buck Converter 2 voltage)
6 AN4 Analog Input 4 (Input Voltage)
7 NC Not Connected
8 Vss Ground Reference for Logic and I/O Pins
9 NC Not Connected
10 NC Not Connected
11 NC Not Connected
12 NC Not Connected
13 VDD Positive Supply for Logic and I/0O Pins
14 NC Not Connected
15 RB15 PMBUSAUX2
16 RB5 PMBUSAUX1
17 SCL SCL/TX
18 SDA SCL/RX
19 Vss Ground Reference for Logic and I/O Pins
20 VDD +3.3V_DIG
21 PWM3H PWM Boost Converter
22 I/0 Load
23 PWM2H PWM 2 High Output (Buck Converter 2)
24 PWM2L PWM 2 Low Output (Buck Converter 2)
25 PWM1H PWM 1 High Output (Buck Converter 1)
26 PWM1L PWM 1 Low Output (Buck Converter 1)
27 NC Not Connected
28 +9V Input Voltage for Two Buck Stages

DS70000336C-page 20
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244 Explorer 16 Development Board Connector J1

The two buck sections and one boost section of the daughter board can be controlled
using the Explorer 16 Development Board. Table 2-2 lists all the power and signal
connections on the daughter board J1 connector to the user interface with the
Explorer 16 Development Board. See Figure A-6 for the location of this connector.

TABLE 2-2: SIGNAL AND POWER CONNECTION FOR THE EXPLORER 16
DEVELOPMENT BOARD (J1)

P';r?nl:;nr:er Assignment Primary Use
79 ANO Analog Input 0 (Buck Converter 1 current)
80 AN1 Analog Input 1 (Buck Converter 1 voltage)
45 PWM1H PWM 1 High Output (Buck Converter 1 drive)
46 PWM1L PWM 1 Low Output (Buck Converter 1 drive)
8 AN2 Analog Input 2 (Buck Converter current)
6 AN3 Analog Input 3 (Buck Converter 2 voltage)
12 PWM2H PWM 2 High Output (Buck Converter 2 drive)
11 PWM2L PWM 2 Low Output (Buck Converter 2 drive)
50 AN4 Analog Input 4 (input voltage)
102 ANS8 Analog Input 8 (Boost Converter current)
80 AN9 Analog Input 9 (Boost Converter voltage)
17 PWM3H PWM3H High Output (Boost Converter drive)
13 I/0 Load Drive for Buck Converter 1 Load
101 AN10 Analog Input 10 (POT RP1)
65 RB15 PMBUSAUX2
66 RB5 PMBUSAUX1
67 SCL SCL/TX
68 SDA SCL/RX
9, 10, 119, 120 3.3VDIG_GND Ground Reference for Digital I/O Pins
21, 22, 53, 54, +3.3V_DIG Digital 3.3V
107, 108
15, 16, 41, 42 9VANA_GND Ground Reference for Logic and 1/O Pins
25, 26, 57, 58 +9V 9V Input Voltage
1-5, 14, 18-20, 23, NC Not Connected
24, 27-30, 33-40,
43, 44, 49, 51, 52,
55, 56, 59-62,
69-78, 81-95,
97-100, 103-106,
109-118
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2.45  VOUT1 J4 (Buck1+)

An external load can be connected to VOUT1 through the J4 connector. One
on-board parallel resistor, R44 (5Q/5W), is connected at the output of VOUT1
through MOSFET Q13 to optionally load the Buck 1 Converter circuit. Resistor R45 is
on-board and there is space to solder resistor R46 onto the board. When resistor R46
is connected to VOUT1, the J11 jumper must be open while working with +9V power
from the control board. The on-board load resistor can be connected to VOUT1 by
controlling the signal name “Load”. The “Load” signal is the I/O pin of the dsPIC DSC
SMPS device and is active-high. See Figure A-2 for the location of this connector.

2.46  VOUT2 J5 (Buck2+)

An external load can be connected to VOUT2 through the J5 connector. VOUT2
can load up to a maximum of 3 amps when the auxiliary input voltage source is
connected at the J9 input connector. See Figure A-3 for the location of this
connector.

2.47  VOUTS3 J8 (Boost)

An external load can be connected to VOUT3 through the J8 connector. VOUT3 can
load up to 0.60 amps when the auxiliary input voltage source is connected at the
J9 input connector. See Figure A-4 for the location of this connector.

2438 Jumpers

The daughter board consists of three jumpers that determine its features. Table 2-3 lists
jumpers and their functions.

TABLE 2-3: JUMPERS

Jumpers Description Default Configurations
J6 Select either 9V power provided by the Explorer 16 | Short with jumper header
Development Board or 16-Bit 28-Pin Starter (closed)
Development Board and an external power supply
J10 Connects potentiometer RP1 to AN10 on Open
Explorer 16 Development Board
J11 Connects R46 load resistor to VOUT1 Open
J12 Buck 2 voltage feedback selection Short with jumper header
(closed)
J13 Buck 2 current feedback selection Short with jumper header
(closed)
J14 Boost current feedback selection Open
J15 Boost voltage feedback selection Open

DS70000336C-page 22
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249 Potentiometer and LED

The daughter board consists of a potentiometer and LEDs for the user application.
Table 2-4 lists components and their functions.

TABLE 2-4: POTENTIOMETERS AND LED

Label Hardware Elements
RP1 Potentiometer connected to AN10 of Explorer 16 Development Board controller
D11 Buck 1 output LED
D12 Buck 2 output LED
D13 Boost output voltage LED
D14 Input voltage LED

2410 Test Points

The daughter board provides the various test points of the PWM signals, feedback
signals, and input and output voltages for the user application. Table 2-5 lists the PWM
test points that can be used to check the PWM gate pulse for all three power stages.

TABLE 2-5: PWM TEST POINTS

Test Points Description
PWM1H Buck MOSFET gate drive of Buck 1 Converter stage
PWM1L Synchronous MOSFET gate drive of Buck 1 Converter stage
PWM2H Buck MOSFET gate drive of Buck 2 Converter stage
PWM2L Synchronous MOSFET gate drive of Buck 2 Converter stage
PWM3H Boost MOSFET gate drive for Boost Converter stage

Table 2-6 lists the feedback signal test points that can be used to check the feedback
signal waveforms and values.

TABLE 2-6: FEEDBACK SIGNAL TEST POINTS

Test Points Description

Current Sense1 | Current feedback signal for Buck 1 Converter stage
Current Sense2 | Current feedback signal for Buck 2 Converter stage
Current Sense3 | Current feedback signal for Boost Converter stage

Table 2-7 shows the power test points that can be used to verify the input and output
voltages.

TABLE 2-7: POWER TEST POINTS

Test Points Description
V+ Input voltage test point
Buck1+ VOUT1 voltage test point
Buck2+ VOUT2 voltage test point
Boost+ VOUTS3 voltage test point
GND Ground potential test point
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2.5 USING THE DAUGHTER BOARD WITH THE EXPLORER 16
DEVELOPMENT BOARD

This section describes the hardware connection of the daughter board with the
Explorer 16 Development Board. Figure 2-3 shows the daughter board hardware
connection (MPLAB ICD 3 and power supply) to the Explorer 16 Development Board.

The dsPIC33FJ64GS610 SMPS device controls both buck stages (Buck 1 and

Buck 2), as well as the boost stage through the Explorer 16 Development Board,
simultaneously.

Note: To operate all three converters using the Explorer 16 Development Board,
ensure that J12, J13 and J6 are shorted with the jumper header, and J14
and J15 are open before powering up the board.

The potentiometer, R6 (10 kQ), in series with the R12 resistor on the Explorer 16
Development Board, is connected to the analog input channel (AN5) of the dsPIC®
DSC SMPS device. The potentiometer, R6 on the daughter board, is connected to the
analog input channel (AN10) through the J10 jumper. Both potentiometers can be used
for development purposes to simulate any feedback signal.

FIGURE 2-3: DAUGHTER BOARD CONNECTED TO THE EXPLORER 16 DEVELOPMENT BOARD

MPLAB® ICD 3

€ad ,avidi
diHI0HIIW

g o

/|
=

o o = \

L ---.-n--u-p-p".“l--lm--uh--._'l -

C+9V Power Supply Connector Buck/Boost Converter PICtail™ Plus Daughter Board Explorer 16 Development Board
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2.6 USING THE DAUGHTER BOARD WITH THE 16-BIT 28-PIN STARTER
DEVELOPMENT BOARD

This section describes the use of a 16-Bit 28-Pin Starter Development Board with the
Buck/Boost Converter PICtail Plus Daughter Board.

Figure 2-4 shows the 16-Bit 28-Pin Starter Development Board and its hardware
elements. For more details, refer to the “16-Bit 28-Pin Starter Development Board
User's Guide” (DS51656), which is available from the Microchip web site
(http://www.microchip.com).

FIGURE 2-4: 16-BIT 28-PIN STARTER DEVELOPMENT BOARD

=Rt .
FPWR

[2as ﬂ”m 5 “'nn
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FIGURE 2-5:

The potentiometer, RP1 (10 kQ), along with the J5 jumper on the 16-Bit 28-Pin Starter
Development Board, is connected to the analog input channel (AN5) of the dsPIC DSC
SMPS device. Figure 2-5 shows the connection of a 16-Bit 28-Pin Starter Development
Board to a daughter board with ICD 3 and a 9V power supply.

Ensure that the following changes are made to the 16-Bit 28-Pin Starter Development
Board prior to connecting it to the daughter board:

» Remove resistors, R14 and R15 (to control Buck 2 or Boost Converter)

* JP1in Pin 1-2 position (supply)

JP2 in Pin 2-3 position (+3.3V)

JP3 in 1-2 position (dsPIC33F/PIC24)

» JP4 open

SW2 in USB/Debug mode

DAUGHTER BOARD HARDWARE CONNECTED TO A 16-BIT 28-PIN STARTER
DEVELOPMENT BOARD

MPLAB® ICD 3

<
E?-
®

N
o
w

2042\

diH

QG-Bit 28-Pin Starter Development Boar(D
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2.6.1 16-Bit 28-Pin Starter Development Board Controls Buck 1 and
Buck 2 Stages (Default Jumper Configuration)

The dsPIC33FJ16GS502 SMPS device controls buck stages, Buck 1 and Buck 2, through
the 16-Bit 28-Pin Starter Development Board as the default configuration on the daughter
board (refer to Table 2-3). The two buck stages can be controlled as multi-phase or as two
parallel converters by shorting the VOUT1 (Buck1+) and VOUT2 (Buck2+) outputs, and
by programming the output of the buck stages to the same output voltage value.

Note 1: To operate the two Buck Converters using the 16-Bit 28-Pin Starter
Development Board, ensure that J12, J13 and J6 are shorted with the
jumper header, and J14 and J15 are open before powering up the board.

2: The software package for the dsPIC33FJ16GS502 device on the web
only provides control for Buck 1 and Buck 2.

2.6.2 16-Bit 28-Pin Starter Development Board Controls Buck 1 and
Boost Stages

This section describes the hardware changes that must be performed to control the Buck 1
and Boost stages. Figure 2-6 displays the feedback jumper, which must be modified in the
daughter board. See Figure A-4 for the complete daughter board schematics.

FIGURE 2-6: FEEDBACK JUMPERS

26.21 HARDWARE
The following hardware changes are required in the daughter board to enable control
of the Buck 1 and Boost Converter stage:

» Jumper J12 and J13: Open
» Jumper J14 and J15: Short with jumper header (close)

26.22 SOFTWARE

The following additional changes in software are required to enable control of the
Buck 1 and Boost Converter stage:

» Boost current feedback through analog input channel (AN2)

» Boost voltage feedback through analog input channel (AN3)

» Boost PWM3 output (PWM3H)

* PWMZ2 output pin must be controlled by 1/0 port and driven low

Note: The software package for the 16-Bit 28-Pin Starter Development Board will
only enable the Buck 1 and Buck 2 converters.
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2.7 POWER RATING OF CONVERTER STAGES

All three DC/DC power stages in a daughter board can be loaded externally through
the output terminal blocks, J4, J5 and J8. For loading any power stage externally, the
user must provide an auxiliary power source to the daughter board through input
terminal block, J9.

2.71 Buck 1 Converter

The Buck 1 Converter stage is rated for a maximum output current of 3 amps through
the J4 connector. The output voltage of the Buck Converter (VOUT1) can be
programmed for a OV-5V output. The hardware gain [5k/(3.3k + 5k)] of the voltage
feedback of VOUT1 is provided by the resistor divider network of R11 and R12. The
hardware gain of the current feedback is provided by the current transformer (TX1) with
turns ratio (1:60) and burden resistor, R5. The circuitry consists of R6, R7, C7 and Q3,
and provides slope compensation for current feedback (Current Sense1).

2.7.2 Buck 2 Converter

The Buck 2 Converter stage is rated for a maximum output current of 3 amps through
the J5 connector. The output voltage of the Buck Converter (VOUT2) can be
programmed for a OV-5V output. The hardware gain [5k/(3.3k + 5k)] of the voltage
feedback of VOUT2 is provided by the resistor divider network of R29 and R30. The
hardware gain of the current feedback is provided by the current transformer (TX2) with
turns ratio (1:60) and burden resistor, R23. The circuitry consists of R24, R25, C14 and
Q8, and provides slope compensation for current feedback (Current Sense2).

2.7.3 Boost Converter

The Boost Converter stage is rated for a maximum output current of 0.60 amps through
the J8 connector. The output voltage of the Boost Converter (VOUT3) can be pro-
grammed up to a maximum output of 20V. The hardware gain [20k/(20k + 3.3k)] of
the voltage feedback of VOUT3 is provided by the resistor divider network of R55 and
R56. The hardware gain of the current feedback is provided by the current sense
resistor, R53 (current sense boost/Current Sense3). The circuitry consists of R13,
R14, C20 and Q4, and provides slope compensation for current feedback

(current sense boost/Current Sense3).

DS70000336C-page 28
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Chapter 3. Getting Started

3.1 OVERVIEW

This chapter provides a more detailed description to getting started using the Buck/
Boost Converter PICtail™ Plus Daughter Board, with the 16-Bit 28-Pin Starter
Development Board, using the dsPIC33FJ16GS502 SMPS device. The 16-Bit 28-Pin
Starter Development Board is modified as per Section 2.6 “Using the Daughter
Board with the 16-Bit 28-Pin Starter Development Board”. While working with the
daughter board, along with the Explorer 16 Development Board using a
dsPIC33FJ16GS610 device, refer to the Explorer 16 board-specific note that is
specified in the corresponding instructions.

3.2 HIGHLIGHTS

This chapter covers the following topics:

» Features

+ Creating the Project

+ Building the Code

* Programming the Device

3.3 FEATURES

This section describes the main features of MPLAB® X IDE and the MPLAB ICD 3
In-Circuit Debugger because they are used in the 16-Bit 28-Pin Starter Development
Board. This section provides information on performing the following tasks:

1. Creating a project using the Project Wizard.

Assembling and linking the code, and setting the Configuration bits.

Setting up MPLAB X IDE to use the MPLAB ICD 3 In-Circuit Debugger.
Programming the chip with MPLAB ICD 3.

Viewing code execution.

Viewing registers in the Watch window.

Setting a breakpoint and setting the code Halt in the specific location.

Using the function keys to Reset, Run, Halt and Single Step the code.

®© Nk wN
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Before performing these steps, save the Buck/Boost Converter PICtail Plus Daughter

Board firmware from the CD in the following location: c:\Program Files\Microchip\.

Note 1:

The demo software using the 16-Bit 28-pin Starter Development Board
will be under folder: C:\Program Files\Microchip\Buck Boost
PICtail Plus Board\Buckl Voltage Mode with 28P Starter
Board.

The demo software using the Explorer 16 Development Board will be
under the folder: C:\Program Files\Microchip\Buck Boost
PICtail Plus Board\3-Stage Voltage Mode with
Explorer 16.

Both the above folders are comprised of the project file (* . mcp) and
workspace file (* .mcw). The user can use these files to program the
device or the user can create their own project and workspace file by
performing the steps listed in this chapter.

3.4 CREATING THE PROJECT

This section describes the process of creating a project and workspace in
MPLAB X IDE. In any particular folder, one project and one workspace are present.

| Note: These instructions presume the use of MPLAB X IDE v2.20 or later.

A project consists of files that are used to build an application (source code, linker script
files, etc.), along with their association to various build tools and build options. The
workspace consists of the following features:

* One or More Projects

* Information on the Selected Device

» Debug Tool and/or Programmer, Open Windows and Their Location
» Other MPLAB X IDE Configuration Settings

MPLAB X IDE provides a Project Wizard to create new projects.

3.41

Creating the Project

Using the Project Wizard involves four steps:

* Selecting the Device

* Selecting the Hardware Tool
* Naming the Project

» Adding Files to the Project

Use the following procedures to complete each of the four steps.
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3.4.1.1

1. Open MPLAB X IDE.

PROJECT WIZARD STEP ONE — SELECTING THE DEVICE

2. Double click on the New Project icon on the menu bar at the top of the window.

FIGURE 3-1:

NEW PROJECT ICON

File Edit View MNavigate

3. Under Categories, select “Microchip Embedded”.

In the Projects section, select “Standalone Project”.

CREATING A NEW STANDALONE PROJECT

4.
FIGURE 3-2:
x New Project
Steps

Choose Project

1. Choose Project
x

i

Categories:

Projects:

| L) Micrachip Embedded
v )} Other Embedded
f-[)) samples

[=]standalone Project

m Existing MPLAB IDE v8 Project

m Prebuilt (Hex, Loadable Image) Project
(G User Makefile Project

{54 Library Project

Description:

Creates a new standalone application project. It uses an IDE-generated makefile to build your
project.

5. Click Next to continue.

© 2008-2014 Microchip Technology Inc.
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6. From the Device drop down list, select the required device as shown in Figure 3-3.

FIGURE 3-3: SELECTING THE DEVICE

3 New Project [_Ji:’-

Steps Select Device

1. Choose Project

2. Select Device

3. Select Header Family: All Families -
4. Select Tool

5. SelectPlugin Board
-8
7.

Select Compiler Device: dsPIC33F1 IEGSSUZI -

Select Project Name and
Folder

< Back Finish Cancel Help

7. Click Next to continue.

3.4.1.2 PROJECT WIZARD STEP TWO — SELECTING MPLAB ICD 3 AS THE
HARDWARE TOOL

8. Inthe Select Tool section, select ICD 3 as the hardware tool being used, as
shown in Figure 3-4.

FIGURE 3-4: SELECTING THE TOOL
rx New Project lé]
Steps Select Tool

1. Choose Project

2,  SelectDevice
B Ha

H- || Microchip Starter Kits
=I-{igd) Other Tools
L2 Licensed Debugger

< Back Finish Cancel Help
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3413

PROJECT WIZARD STEP THREE — SELECTING THE COMPILER

9. Inthe Select Compiler section, select the compiler as in Figure 3-5.

FIGURE 3-5: SELECTING THE COMPILER
rx Mew Project Lﬁw
Steps Select G

Choose Project
Select Device
Select Header

Select Plugin Board
select Compiler
Select Project Name and
Folder

1

2,

3.

4. Select Tool
5

6.

7.

. Compiler Toolchains
-ASM30
--A5M30 [C:YProgram Files (x86) \Microchip\MPLAB C30%bin]
--A5M30 [C:YProgram Files (x86) \Microchip\MPLAB C30_300'bin]

L.c30 [C:\Program Files (x86)\Microchip\MPLAB C30'bin]
30 [C:\Program Files (x86)\Microchip\MPLAB C30_300'bin]
dsPIC {None found)

HI-TECH DSPICC {Mone found)

(C15

XC16 (v1.21) [C:\Program Files (x86)Wicrochipipc 16w 1. 21%bin]
¥C16 (v1.20) [C:\Program Files (x86)WMicrochipipc 164w 1. 20%hin]
¥C16 (w1.11) [C:\Program Files (x86)WMicrachiplxc 164w 1. 11'hin]
XC16 (v1.10) [C:\Program Files (x85)WMicrochiplxc 164w 1. 10'bin]
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3.4.1.4 PROJECT WIZARD STEP FOUR — NAMING THE PROJECT AND
SAVING IT TO USER-SPECIFIED LOCATION

10. In the Select Project Name and Folder window, name the project that is being
created as Buck1 Voltage Mode.

11. As shown in Figure 3-6, in the Project Location tab, click the “Browse ... and
navigate to”:

C:\Program Files\Microchip\Buck BoostPicTail Plus Board\Buckl Voltage
Mode with 28P Starter Board.

FIGURE 3-6: SELECTING PROJECT NAME AND PROJECT LOCATION
x New Project tﬁj
Steps Select Project Name and Folder
1, Choose Project
2. Select Device
i‘ gz::g_’:s;der Project Name: Buck1 Voltage Mude|
o s Project Location: Buck BoostPicTai Plus Board|Buck1 Voltage Mode with 28P Starter Board. | [ Browse...
7 ?:II:::: Pegjcat Home and Project Folder: Board\Buck1 Voltage Mode with 28F Starter Board, \Buck1 Yoltage Mode. X

Overv ject.

|| Set as main project

|| Use project location as the project folder

Enceding: 150-88529-1 -

Project name and folder path length are nearing the Windows limit. This may cause issues during build or project
{4 creation.
Try shortening the project name or path.

< Back Next = Finish || Cancel H Help

12. Click the Finish button to complete and create the new project.
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3.41.5 PROJECT WIZARD STEP FIVE — VIEWING THE PROJECT

13. On the left-hand side of the MPLAB X IDE window is the project listing. The
MPLAB X IDE will automatically list all the files associated with the project.

FIGURE 3-7: PROJECT FILE LISTING

File Edit View MNavigate Sour

7 7 =&
m‘i Files : BUC...

--[d Buckl Voltage Mode
—Eﬁ Header Files

EI configs.h
[ defines.h
[ dsp.h
Ia iwr.h
-] main.h

Ia smps_control.h

-[iF Important Files

[ Linker Files

(g Source Files
-

’-E‘] isr.c

-] main.c

-] traps.c

i-[[F Libraries

+EJ‘ Loadables

-
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3.5 BUILDING THE CODE

Building the code consists of the following process:

» Assembling all of the *.c and *. s files to create the respective object files (* . o)

+ Linking the object files to create the Buckl Voltage Mode.hex and
Buckl Voltage Mode.cof output files

The . hex file contains the specific data to program the device. The . cof file contains
additional information for debugging at the source code level.

3.5.1 Building the Code

To build the code, click on the Clean and Build Main Project icon at the top of the
MPLAB X IDE, as shown in Figure 3-8.

FIGURE 3-8: BUILDING THE PROJECT ICON

L]

If building the code is successful, a message at the bottom of the output window will
state:

“Loading Completed”
Otherwise, error messages will appear.
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3.6

PROGRAMMING THE DEVICE

The MPLAB ICD 3 In-Circuit Debugger can be used to program and debug the
dsPIC33FJ16GS502 device in-circuit on the daughter board.

3.6.1

Setting Up the Device Configuration

Select Window>PIC Memory Views>Configuration Bits from MPLAB X IDE to display

the Configuration bit settings, as shown in Figure 3-9. The Configuration Bits window
appears, as shown in Figure 3-10.

FIGURE 3-9:

CONFIGURATION MENU

ha AU - 2 B & -

eam Tools Help
<=

Projects nov z c oab sab IPD Hov
[ Files Ctrl+2
@ Classes Ctrl+9
Favorites Ctrl+3
% Services Ctrl+5
g Tasks Ctrl+6
% Dashboard
Output L2
Mavigating >
Debugging ke
Versioning >
PIC Memory Views Program Memory
Simulator File Registers
Other SFRs
Editer Ctrl+0 Configuration Bits
Close Window Ctrl+W i
Maximize Window Shift+Escape e
Undock Window Alt+5Shift+D

Clone Document
Close All Documents

Close Other Documents

Ctrl+1

Ctrl+Shift+W

Documents... Shift+F4
Reset Windows
FIGURE 3-10: CONFIGURATION SETTINGS
: Output [: Tasks : Configuration Bits
Name  Value Field  Option Category Setting
B3 000F BWRE  [WREROIECI_OFF ., Boot Segment Write Protect [Boot Segment may be written -
No_FLASH Boot Seguent Program Flash Code Erotection No Boot program Flash segment
65 0067 oFF Genezal Code Segment Write Frotect Genezal Segment may be written
oFF General Segment Code Protection General Segment Code protect is disabled
FOSCSEL FEFE FRC Gsciliator Source Selection Internal Fasc RC (FRC)
o Tnternal External Switch Over Vode Start up device with FRC, then switch to user-selected oscillator source
F0SC  FETB WONE Erimary Oscillator Source Erimary Oscillator disabled
o 2 Fin Fanction 0SC2Z is general purpose digital 1/0 pin
cszam Clock Switching Mode bits Clock switching is enabled, Fail-safe Clock Monitor is disabled
FWOI  FE7F  WOTBOST PS3276e Watchdog Timer Postacaler 1:32,768
WOTPRE  PR1ZE WOT EPrescaler 1:122
WINDIS  OFF Watchdog Timer Window Watchdog Timer in Non-Window mode
FWDIEN  OFF Watchdog Timer Enable Watchdog timer enabled/disabled by user software
[Fe000C  FEOR 0067  FEWRT  EWR1ZE E0R Timer Value 125ms
ELTSSL O Enable Alternate 551 pin bit SS1A is selected as the 170 pin for SPIL
BLIOI0  CEF Enable Alternate QEIL pin bit QERL, QES1, INDXL are selected as inputs to QEIL
Fed00E  FICD  FEDF ICS PEDL Comm Channel Select Cormunicate on PGCL/EMICL and PEDL/EMUDL
STAGER  OFF JT2G Eort Enable TTAG is dissbled
[Feo0lc  ToME  003F  EYSTO  EYST4S Even Comparator Hysteresis Select 45 uv Hysteresis
CMPEOLO  POL_FALL Comparator Hysteresis Folarity (for even numbered comparators) fysteresis is applied to falling edge
EYSTL  HYST4S 0dd Comparator Hysteresis Select 35 m Hysteresis
CMPFOLL FOL_FALL Comparator Hysteresis Folarity (for odd nambered comparators) fysteresis is applied to Zalling edge
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To program the device, click on the Make and Program Device Main Project icon, as
shown in Figure 3-11.

FIGURE 3-11: PROGRAMMING THE DEVICE

Window Help

e MR-

To debug the device, click on the Debug Main Project icon at the top of the
MPLAB X IDE, as shown in Figure 3-12. Alternatively, from the top menu, select
Debug>Debug Main Project.

FIGURE 3-12: PUTTING DEVICE IN DEBUG MODE

dindow Help

MY N

Once in Debug mode, the user has the options of running, pausing, stepping into, step-
ping over, run to cursor, set PC at cursor or focusing cursor at PC. Please refer to the
“MPLAB X IDE User’s Guide” (DS50002027) for further details regarding application
code debugging options and extended features.
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Chapter 4. Demonstration Program Operation

41 OVERVIEW

The Buck/Boost Converter PICtail Plus Daughter Board CD, supplied with the Buck/
Boost Converter PICtail™ Plus Daughter Board, consists of the source code for the
16-Bit 28-Pin Starter Development Board (Buck 1 Converter stage only) and

Explorer 16 Development Board (Buck 1, Buck 2 and Boost Converter stages). To
demonstrate a program that illustrates PID control of the output voltage on the daughter
board, program the device with the respective source code which is available on the
daughter board’s CD, specified in Section 3.4 “Creating the Project”. The code can
also be downloaded from the Microchip web site (http://www.microchip.com).

4.2 HIGHLIGHTS

This chapter includes the following topics:

« Program Demonstration
« Code Demonstration
« Other Code Examples

4.3 PROGRAM DEMONSTRATION

The demonstration program provides simultaneous closed-loop control of the
output voltages.

The PID control scheme consists of the following parameters:

» Proportional Error Gain (P-Gain) — This parameter produces a correction factor
that is proportional to the magnitude of the output voltage error.

- Integral Error Gain (I-Gain) — This parameter uses the cumulative voltage error
to generate a correction factor that eliminates any residual error due to limitations
in offset voltages and measurement resolution.

« Derivative Error Gain (D-Gain) — This parameter produces a correction factor
that is proportional to the rate of change of the output error voltage, which helps
the system respond quickly to changes in the system condition.

Additional control parameters that the user can add to P, | and D-Gain terms are as
follows:

» Second Derivative or Jerk Error Gain (J-Gain) — This parameter produces a
correction factor that is proportional to the change in the differential error (i.e., the
derivative of the derivative). J-Gain is a high-frequency term that tends to provide
quick response to an impulse event.

- Feed Forward Gain — This parameter produces a correction factor based on the
desired output voltage that is computed based on the magnitude of the input
voltage, inductor current and circuit attributes (i.e., inductor and capacitor values).
This term allows the control loop to be proactive rather than reactive. In other
words, when the input voltage changes, Feed Forward Gain responds so that the
control loop does not have to wait until the output voltage changes before making
the appropriate gain correction.
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- Dead-Time Gain — This parameter produces a correction factor that compensates
for the fact that the Feed Forward Gain term does not account for the energy lost
due to the dead time of the PWM signal (the time when both MOSFETs are off).

« Current-Limit Gain — This parameter limits the cumulative control gain when the
current is approaching its upper limit.

After the modifications have been made to the 16-Bit 28-Pin Starter Development
Board, as specified in Section 2.6 “Using the Daughter Board with the 16-Bit
28-Pin Starter Development Board”, do the following:

« Connect the power supply
« Connect MPLAB ICD 3

» Connect the Buck/Boost Converter PICtail Plus Daughter Board
« Connect the 9V power supply to the 16-Bit 28-Pin Starter Development Board, as
shown in Figure 2-5

Instructions for programming the dsPIC33FJ16GS502 SMPS device are provided in the
Readme file of the respective software folder. Chapter 4. “Demonstration Program
Operation” also describes how to program the dsPIC33FJ16GS502 device using
MPLAB ICD 3. Figure 4-1 illustrates the program flow of the demonstration program.

Note: While using the Explorer 16 Development Board with the daughter board,
the output voltages, Buck1+, Buck2+ and Boost+, can be verified by
measuring at output terminals, J4, J5 and J8, respectively.

FIGURE 4-1: SMPS DEMONSTRATION PROGRAM FLOWCHART

Initialization Routines:

» Peripherals — ADC, PWM, Timers, GPIO, etc.

» Variables — PID Gain Terms, Data Buffers

+ Constants — Desired Voltage, Current Limit, etc.
* Interrupts — ADC, Timers

ADC Interrupt

ADC Interrupt Routines:
* Measure VouT

» Calculate PID Gain

» Update PWM Duty Cycle

Soft Start Routine

Idle Loop Functions: Wait for ADC Interrupt

Y
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4.4 CODE DEMONSTRATION

4.4.1 System Initialization

When power is applied to the board, the program starts by executing the following system
initialization routines:

» Peripherals — The required peripherals (PWM, ADC, timers and GPIO) are
configured and enabled.

 Variables — Program variables are defined. RAM locations and register usage are
defined and documented.

» Constants — Program constants are defined, including reference set points for
both VOUT1 and VOUT2, input voltage, current limits, Fault conditions,
PWM periods and timer periods.

« Interrupts — The ADC and timer interrupts are set up and enabled.

» System Stabilization — All outputs are discharged to ensure a stable value at
start-up.

4.4.2 Fault Check

The program checks the ADC for input undervoltage and output overvoltage conditions.
If a Fault occurs, the PWM outputs are disabled until the Fault condition is cleared. If
no Fault is detected, the program proceeds.

443 Soft Start

The Soft Start routine ramps up the output voltage in an open-loop fashion to bring the
system within the operating range of the PID control loop. This routine ensures that the
output does not overshoot the desired voltage. It also limits the current at start-up.

4.4.4 ADC Interrupt

The ADC interrupt is the heart of the demonstration program. This routine takes up
approximately 75% of the execution time. It performs all the PID calculations and applies
any needed corrections to the output.

4.4.5 System Idle Loop

Note 1: The ADC interrupt can occur any time during program execution.

2: The ADC interrupt takes priority over any other tasks that the program is
performing.

All auxiliary functions are performed in the system Idle routine. This is the time available
to the CPU while the demo program is waiting for an ADC interrupt. Non-critical functions
can be performed in this loop. During this time, the input voltage, Fault timers and Soft
Start flag are checked.

45 OTHER CODE EXAMPLES

There are several other code examples available on the Microchip web site. Refer to
the Readme files located in each code example folder for details on what each code
example demonstrates. Check the Microchip web site (http://www.microchip.com) for
the latest updates to the code examples and for additional code examples.
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Appendix A. Board Schematics and Layout

A.1  INTRODUCTION

This appendix provides the detailed technical information on the Buck/Boost Converter
PICtail™ Plus Daughter Board.

A.2 BOARD SCHEMATICS AND LAYOUT

The following are the Buck/Boost Converter PICtail Plus Daughter Board layouts and
schematics:

* Daughter Board Layout

» Daughter Board Schematic 1 of 5

» Daughter Board Schematic 2 of 5

» Daughter Board Schematic 3 of 5

» Daughter Board Schematic 4 of 5

» Daughter Board Schematic 5 of 5
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FIGURE A-5: DAUGHTER BOARD SCHEMATIC 4 OF 5
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FIGURE A-6:

DAUGHTER BOARD SCHEMATIC 5 OF 5
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Appendix B. Bill of Materials (BOM)

B.1 INTRODUCTION
This appendix provides the Bill of Materials (BOM) for the Buck/Boost Converter
PICtail™ Plus Daughter Board.
TABLE B-1: BILL OF MATERIALS
DNP | Qty Ref. Description Mfgr. Mfgr. Part No.

4 |C10,C11, | SMD TANTALUM CAPACITORS 150 uyF 6V | AVX TPSD157K006R0050
C17,C18 |{10%D

4 |J4,J5,J8, | TERM BLOCK PCB 2 POS 5.0 mm GREEN | Phoenix Contact 1935161
J9

9 |C12,C15, | CAP 1 yF 25V CERAMIC X7R 0805 Panasonic — ECG ECJ-2VB1E104K
C16, C19,
C24,C28,
C8, C9,
C4

3 [C20,C14, | CAP CERM 2200 pF 5% 25V NP0 0805 ACX Corp. 08053A222JAT2A
c7

2 |C5,C2, CAP 470 pF 50V CERM CHIP 0805 SMD Panasonic — ECG ECJ-2VC1H471J
C3

4 |C29,C30, | CAP CER 4.7 pyF 25V X5R 1206 Taiyo Yuden TMK316BJ475KL-T
C25, C26

3 |C13,C27, | 220 uF 25V ELEC CAP Rubycon 2571 220M8X11.5
C6

1 |C22 CAP ELECT 100 pF 25V VS SMD Panasonic — ECG EEE-1EA101P

2 |D3, D7 DIODE SCHOTTKY 1A 40V SMA Fairchild Semiconductor | SS14

3 |D10,D15, | SCHOTTKY 3A 30V RECTIFIER Fairchild Semiconductor | SS33
D16

5 [J6,J12, CONN HEADER 2 POS .100" SGL GOLD Samtec Inc TSW-102-07-S-S
J13, J14,
J15

1 ]J2 CONN RCPT .100" 28 POS DUAL GOLD Samtec Inc SSW-114-01-G-D

4 |D11,D12, |LED GREEN CLEAR 0805 SMD LITE-ON INC LTST-C170KGKT
D13, D14

5 |R10,R15, | RES 5.10 kOhm 1/8W 1% 0805 SMD Rohm MCR10EZHF5101
R28, R40,
R43

3 |R11,R56, | RES 3.30 kOhm 1/8W 1% 0805 SMD Rohm MCR10EZHF3301
R29

5 |R20,R31, |RES 3.30 kOhm 1/10W 1% 0603 SMD Panasonic — ECG ERJ-3EKF3301V
R34, R32,
R33

2 |R12,R30 |RES 4.99 kOhm 1/8W 1% 0805 SMD Rohm MCR10EZHF4991

© 2008-2014 Microchip Technology Inc.
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TABLE B-1: BILL OF MATERIALS (CONTINUED)
DNP | Qty Ref. Description Mfgr. Mfgr. Part No.
4 |R13,R24, | RES 20.0 kOhm 1/8W 1% 0805 SMD Rohm MCR10EZHF2002
R55, R6
6 |R14,R25, | RES 2.20 kOhm 1/8W 1% 0805 SMD Rohm MCR10EZHF2201
R7, R47,
R57, R58,
1 |R37 RES 470 Ohm 1/16W 1% 0805 SMD Panasonic — ECG ERJ-6ENF4700V
5 |R22,R39, | RES 1.00 kOhm 1/8W 1% 0805 SMD Rohm MCR10EZHF1001
R4, R42,
R54
2 |R23,R5 |RES 20.0 Ohm 1/8W 1% 0805 SMD Rohm MCR10EZHF20R0
5 |R26,R27, | RES 22.0 Ohm 1/8W 1% 0805 SMD Rohm MCR10EZHF22R0
R52, R8,
R9
4 |R41,R59, | RES 10.0 kOhm 1/8W 1% 0805 SMD Rohm MCR10EZHF 1002
R60, R45
1 |R53 RES .50 Ohm 1W 1% 2512 SMD Vishay/Dale WSL2512R5000FEA
1 |R44 RESISTOR WIREWOUND 5.0 Ohm 5W Ohmite 25J5R0E
2 |U1, U2 IC DVR HALF-BRIDGE HV 8-SOIC National Semiconductor |LM5101M/NOPB
4 |Q1,Q2, |30V N-CHFAST SWITCHPOWER TR Fairchild Semiconductor | FDS6298A
Qe6, Q7 MOSFET
1 1Q13 30V 9A 11.5 Ohm NCH POWER TR Fairchild Semiconductor | FDS6692A
1 Q14 MOSFETs SOT-223 N-CH 30V Fairchild Semiconductor | FDT459N
7 |D1,D2, DIODE SW 75V 215 mA HS SOT-23 NXP BAS16 T/R
D4, D5,
D6, D9,
D8
4 |Q11,Q4, | TRANS NPN 40V 0.8A SOT-23 Fairchild Semiconductor |BSR14
Q3, Q8
1 Q12 TRANS PNP 60V 0.8A SOT-23 Fairchild Semiconductor | BSR16
4 |Buck1+, |TEST POINT PC MULTI-PURPOSE RED Keystone 5010
Buck2+,
Boost+,
VIN
4 | GND, TEST POINT PC MULTI-PURPOSE BLACK | Keystone 5011
GND,
GND,
GND
3 |J6,J12, |SHUNT LP W HANDLE 2 POS SN Tyco Electronics Amp 4-881545-2
J13
2 |TX1,TX2 | SMT CUR SENSE XFMR CoilCraft CST1_060L
2 |L3, L4 INDUCTOR 10 pH 3.9A CoilCraft DO3316P-103ML
1 |L5 INDUCTOR 22 uH 2.7A CoilCraft DO3316P-223ML
1 |U3 IC MOSFET DVR 1.2A DUAL HS 8-SOIC Microchip Technology Inc. | TC1428COA
X D17, D18 | DIODE SCHOTTKY 30V 300 mA SOT-23 Micro Commercial Co. BAT54S-TP
X J3 CONN HEADER 6 POS .100" SNGL TIN Samtec Inc TSW-106-05-T-S
X J1 CONN HEADER 2 POS .100" SNGL GOLD | Samtec Inc TSW-102-07-S-S
X R46 RESISTOR WIREWOUND 5.0 Ohm 5W Ohmite 25J5R0E
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TABLE B-1: BILL OF MATERIALS (CONTINUED)

DNP | Qty Ref. Description Mfgr. Mfgr. Part No.
X J10 CONN HEADER 2 POS .100" SNGL GOLD | Samtec Inc TSW-102-07-S-S
X RP1 POT 5.0 kOhm THUMBWHEEL CERM ST Bourns Inc. 3352T-1-502
X R21 DNP — —

X R3 DNP — —
X TP3 DNP — —
X TP4 DNP — —
X TP5 DNP — —
X TP6 DNP — —
X TP7 DNP — —
X TP14 DNP — —
X TP15 DNP — —
X TP16 DNP — —
X R1, R2 DNP — —
X R35, R36 |DNP — —

© 2008-2014 Microchip Technology Inc.
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